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Introduction 

1.1 General description 

Xpect is a ‘24/7’ transport stream monitoring software package, which continuously checks transport 
streams for compliance to TR 101 290 and compares each stream to a user-created template 
(defining the expected properties of the transport stream). Any violations of the TR 101 290 rules, or 
mismatches to the template, will be logged in a database and can be signalled to an NMS through 
SNMP traps or as an IP/UDP based message.  

Xpect also keeps logs of statistical information (e.g. bitrates, number of CC errors and scrambled 
status) for the services, tables and individual components in the monitored stream. The period over 
which to gather the statistical information is user-configurable and can be set from several second 
up to multiple days/weeks. 

Xpect monitors multiple transport streams simultaneously, applying different test criteria to each 
stream. Each stream is independently monitored and can be paused without affecting the other 
streams, for example when new test criteria are being loaded by the user. The maximum number of 
streams that can be monitored in parallel is defined by the required configuration, the bit rate for 
each transport stream and the resource availability of the host PC (Xpect server). 

The Xpect server software is installed on a PC platform, it consists of the main Xpect ‘application’ 
and a companion ‘guardian’ service. The Xpect guardian will launch and shut down Xpect gracefully 
to protect its databases against corruption should a user-invoked shut-down be attempted during 
database writes. Furthermore, the Xpect guardian will regularly communicate with each Xpect 
‘instance’ (TS monitoring thread) to ensure they are each running properly. If an instance does not 
respond within a time limit then the Xpect guardian will automatically re-initialise that instance 
without interrupting the monitoring of the other instances. Once configured, each Xpect monitoring 
instance is designed to run autonomously without any human supervision. 

For remote control purposes Xpect provides both SNMP and SOAP interfaces. These will allow a 3rd 
party NMS, or custom-built client application, to fully configure Xpect and download captured 
transport stream files as well as giving full access to the event log and statistical information 
databases. Finally, Xpect provides a web interface which can be used to check the live status of the 
monitored stream, access event logs and perform basic configuration tasks using a standard 
browser. 

The Xpect software runs on a standard Windows based PC (Win XP, 2k3, Vista, 2k8 or Win 7) and 
can be combined with almost all DekTec hardware input devices. Using a DekTec hardware 
interface, you will be able to monitor transport streams from DVB-ASI, DVB-T, DVB-S(2) and IP 
networks. 
  



  DTC-720 Xpect – 24/7 Transport Stream Monitoring 
  USER MANUAL 

 4 

1.2 Licensing 

As is true for most other DekTec software applications, Xpect requires the presence of a valid licence 
before it can be used. The Xpect software uses a licence point mechanism. The basic idea behind 
this point based license mechanism is that you need a certain amount of licence points per 
monitored transport stream (see table below). 

TS type Points Description / Remarks 

SPTS Radio ¼ A single-program transport stream carrying a radio service. 

SPTS TV ½ A single-program transport stream carrying a TV service. 

MPTS 4 A multi-program transport stream i.e. stream carrying multiple services 

Given the above you can compute the number of licence points needed to run Xpect on the basis of 
the number of multi- and/or single-program transport streams you want to monitor. For an example 
of how to compute the number of points required please refer to §2.5 Number of licence points. 

NOTE: you can only buy whole points, therefore the number of total number points required must 
be rounded upwards to the nearest whole number (e.g. if your setup requires 7.75 points you must 
round this up to 8 points). 

1.2.1 How long is a licence valid? 

There are two types of licence available for Xpect, the first being a time limited evaluation licence 
and the second a permanent licence. 

The evaluation licence is intended for evaluation purposes and will always be time-limited (i.e. after 
a certain amount of time the licence will expire and Xpect will no longer be able to run). 

A permanent licence will never expire; however, it does have a time-limited maintenance period 
associated with it (by default: 1 year). This means that you will be able to freely upgrade to the latest 
Xpect version as long as it was released prior to the end date of the maintenance period. If you 
upgrade to a version which was released after the maintenance end date the licence will not be 
accepted and you will need to renew the maintenance period to be able to use the latest version. 

NOTE: your licence will still be valid for any Xpect version released prior to the maintenance end 
date (i.e. you can still use the older version). 

1.2.2 Where is the licence located? 

Although you may have received a file with the licence for Xpect, the licence itself will be stored on a 
DekTec card after you have activated the licence. This means that the file is no longer needed after 
activation and that the DekTec card is effectively a dongle for Xpect (i.e. the licence moves with the 
DekTec hardware). It is possible to have multiple DekTec cards with Xpect licences on more than one 
of them.  

When Xpect starts it will check all cards which are part of its configuration (i.e. cards which are 
specified in the XpectGeneralConfig.xgen configuration file) to see if they have a valid licence. The 
points of all valid licences will be accumulated and if there are enough points available to run the 
configuration, Xpect will start. For example if the configuration contains two cards ‘A’ and ‘B’ with 
respectively a licence for four and two points on them, Xpect will start successfully as long the 
number of licence points needed does not exceed six points. 

NOTE: if your system contains the cards ‘A’, ‘B’, and ‘C’, and a valid Xpect licence is stored on each 
of them, but card ‘C’ is not used in the configuration of Xpect (i.e. no transport stream received via 
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card ’C’ will be monitored), then the licence points on card ‘C’ will not be included in the sum of 
available points. 

1.3 List of Abbreviations 
 

CATV Cable Television 

CC Continuity Count 

DVB Digital Video Broadcasting 

EULA End User Licence Agreement 

IP Internet Protocol 

Mbps Megabits per second 

MIB Management Information Base. The set of status and control variables 
accessible through the SNMP protocol 

MPTS Multi-Program Transport Stream 

NA Not Applicable 

NMS Network Management System 

PCI PCI Bus 

PCIe PCI Express Bus 

PCR Program Clock Reference 

ppm Parts per million 

SNMP Simple Network Management Protocol 

SPTS Single Program Transport Stream 

TSoIP Transport Stream over IP 

UDP User Datagram Protocol 

URL Uniform Resource Locator 

XCT Xpect Configuration Tool. A tool for editing and creating Xpect configuration 
files 
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2. Pre-installation considerations 

Before explaining how to configure Xpect, we will first discuss some important considerations related 
to the choice of the PC and DekTec interface(s). 

The desired setup has a big impact on the hardware requirements needed to run Xpect smoothly 
and it is therefore important to ask yourself a number of questions prior to selecting a hardware 
platform for your Xpect installation. The table below lists a number of requirements and the 
parameters on which they depend. 

# Requirement Depends on 

1 Minimum system specification  Windows OS used 
2 Amount of memory (RAM) needed  Number of transport streams monitored 

 Size of pre- and post-trigger buffers 
3 Hard disk space needed  Number of transport streams monitored 

 Will transport stream capturing will used? 
 Number of days to keep in log databases 

4 Number of DekTec interface cards  Number of transport streams monitored 
 Which interface types are used (DVB-ASI, DVB-T, 

DVB-S(2), TSoIP, etc)? 
 Can you use cards with multiple input ports? 

5 Number of licence points  Number of transport streams monitored 
 Type of transport streams (i.e. SPTS Radio/TV or 

MPTS) 

2.1 Minimum system specs 

The minimum system specifications for running Xpect are given in the table below. 

Platform: Win XP, 2k3, Vista, 2k8 or Win 7 

NOTE: both 32-bit and 64-bit operating systems are supported 

Processor: P4 3GHz or better 

Memory: ≥1GB RAM 

Hard disk: Minimum of 1GB of free space 

PCI/PCI Express Enough free slots to fit required DekTec interface cards 

Prerequisites .NET 2.0 with SP1, .NET 4.0 and Silverlight 4 runtime 

NOTE: Please also check minimum system requirements for the Windows OS you will be using 

NOTE: In the next sections we will go into the memory and hard disk requirements in more detail 

2.2 Xpect server: required memory 

The amount of memory required for Xpect consists of two parts, namely: (1) the minimum amount of 
memory required for the Windows operating system and (2) the runtime amount of memory 
required by Xpect itself. For the first we recommend you consult the system requirements of the 
Windows version you will be using; but, as a minimum, we recommend at least 1GB. The runtime 
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memory requirements depend on the number of transport streams and the sizes of the pre- and 
post-trigger buffers. 

To compute the amount of memory required for an Xpect server the Xpect Configuration Tool could 
be used to define your configuration and show the memory required for Xpect: 

 

MREQ = MOS + MRUNTIME, where 

   MREQ = Total amount of memory required for an Xpect system 

   MOS = Minimum amount of memory required by Windows (typical=512MB) 

 

For example, suppose you have a setup with 4 transport streams and with the pre- and post-trigger 
buffer sizes set to respectively 32MB and 16MB. In this case the total amount of memory required 
would be: 

MREQ = 512 + 562  

MREQ =  >1GB 

 

IMPORTANT NOTE: 

The 32-bit Xpect version cannot use more than 2GB (i.e. MRUNTIME ≤ 2GB) even if your system 
contains more memory. Also note that the runtime memory required by Xpect (MRUNTIME) must not 
exceed 75% of the total amount of memory available. Xpect applies this restriction to ensure the 
system does not become unusable due to resource starvation. 



  DTC-720 Xpect – 24/7 Transport Stream Monitoring 
  USER MANUAL 

 8 

2.3 Xpect server: required hard disk space 

Like the memory usage, the required hard disk space depends on a number of variables such as the 
number of transport streams, pre- and post-trigger buffer sizes and the maximum number of entries 
to be stored in the log database. 

The required disk space can be computed using the formulae below (all values in MB): 

HDCAP = (BPRE + BPOST) x (212 ÷ 188) x NFILES, where: 

   HDCAP = Amount of disk space required for transport stream captures 

   BPRE = Size of pre-trigger buffer 

   BPOST = Size of post-trigger buffer 

   NFILES = Number of transport streams capture files to store 

 

HDLOG = NLOG × SLOG, where 

   HDLOG = Amount of disk space, per TS, required for the log database 

   NLOG = Maximum number of log entries to store 

   SLOG = Size of log entries in database (typically = 1kB) 

 

HDSTAT = (NSHORT + NMEDIUM + NLONG) × (NSVC + NBS + NTBL) × Sstat, where 

   HDSTAT = Amount of disk space, per TS, required for the statistics database 

   NSHORT = Maximum number of short-term statistics entries to store 

   NMEDIUM = Maximum number of medium-term statistics entries to store 

   NLONG = Maximum number of long-term statistics entries to store 

   NSVC = Number of services in transport stream 

   NBS = Number of basic streams in transport stream 

   NTBL = Number of tables in transport stream 

   SLOG = Average size of log entries in database (typically = 1kB) 

 

HDREQ = NTS × (HDCAP + HDLOG + HDSTAT), where 

   HDREQ = Total amount of required disk space 

   NTS = Number of transport streams monitored 

 

For example, suppose you have a setup with 4 transport streams, with pre- and post-trigger buffer 
sizes of respectively 32MB and 16MB, a maximum of 16 capture files are stored on disk, the 
number of log entries is limited to 100,000 and the number of short-, medium- and long-term 
statistics entries is set to 60, 60 and 48 respectively, the number of services is 8, number of basic 
streams is 40 and the number of tables is 60. In this case the total hard disk space required would 
be: 

HDCAP = (32 + 16) × (212 ÷ 188) × 32 = ~866MB 
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HDLOG = 100,000 × 1kB = ~98MB 

HDSTAT = (60 + 60 + 48) × (8 + 40 + 60) × 1kB = ~18MB 

HDREQ = 4 × (866 + 98 + 18) = ~3928MB 

 

NOTE: in the above formulae we do not account for the disk space required for installing Xpect, 
however, this is a relatively small amount (<100MB) that it can be disregarded. 

2.4 Number of DekTec cards 

It is important to consider the number and type of DekTec input cards (DVB-ASI, DVB-T, DVB-S(2), 
TSoIP, etc) required for your setup. The number of cards needed depends largely on the number of 
transport streams you will be monitoring. The number of cards used will have an impact on the 
number of available PCI/PCIe slots your target PC will need to have. If the number of PCI/PCIe slots 
in your target PC is limited, it is worthwhile considering the use of a DekTec card with multiple input 
channels on a single board (if available for the type of interface you need). See our website for 
details of the currently available input cards (www.dektec.com). 

2.5 Number of licence points 

Xpect uses a point-based licensing system (see §1.2 Licensing). The number of licence points 
required depends on the number of transport streams you will be monitoring and the type of 
transport stream (single- or multi-program). 

The formula below can be used to compute the number of required points: 

LPTOT = (NSPTSRAD × LPSPTSRAD) + (NSPTSTV × LPSPTSTV) + (NMPTS × LPMPTS), where 

   LPTOT = Number of licence points required 

   NSPTSRAD = Number of single-program radio transport streams to monitor 

   LPSPTSRAD = Number of licence points (=¼) required for each SPTS Radio 

   NSPTSTV = Number of single-program TV transport streams to monitor 

   LPSPTSTV = Number of licence points (=½) required for each SPTS TV 

   NMPTS = Number of multi-program transport streams to monitor 

   LPMPTS = Number of licence points (=4) required for each MPTS 

 

For example, suppose you have a setup where you want to monitor eight radio SPTS streams, two TV 
SPTS streams and three MPTS streams: 

LPTOT = (8 × ¼) + (2 × ½) + (3 × 4) = 15 licence points 

 

http://www.dektec.com/
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3. Installation 

In this chapter we will discuss how to set up an Xpect server. Before continuing, please make sure 
you have read the §2. Pre-installation considerations and have selected a suitable PC for use with 
Xpect. 

The two installation steps are discussed in the following sections. 

3.1 Hardware installation 

The table below lists the hardware installation steps 

# Action Description 

1 Install driver(s) prior to inserting 
DekTec interface cards 

 Download the latest version of the DekTec Dta1xx driver 
(Dta1xx.zip) and/or Dtu2xx driver (Dtu2xx.zip) from the 
DekTec website 
(http://www.dektec.com/Downloads/Drivers.asp); 

 If you will be using PCI/PCIe cards extract the ‘Dta1xx.zip’ 
file and run the Dta1xx driver installation program 
(‘Dta1xx setup.exe’); 

 If you will be using USB-2 adapters extract the 
‘Dtu2xx.zip’ file and run the Dtu2xx driver installation 
program (‘Dtu2xx setup.exe’); 

 Continue to step 2 
2 Insert DekTec interface cards in 

target PC 
 Power down the PC; 
 Open the PC housing; 
 Carefully insert each DekTec card in PCI/PCIe slots; 
 Close PC housing; 
 Continue to step 3 

3 Boot PC to complete driver 
installation 

 Power-up the PC; 
 Shortly after logging on, the “Found New Hardware 

Wizard” should pop-up to indicate Windows has found 
new hardware; 

 Choose “Install the software automatically 
(Recommended)”; 

 Press “Next” and “Finish”, and the driver installs; 
 If you have fitted multiple cards this process may be 

repeated several times; 
 Now your hardware should have been installed 

successfully and you are ready to move on to the 
software installation phase. 

NOTE: In the above steps we are assuming the driver(s) will be installed prior to inserting the 
DekTec interface cards. It is also possible to first insert the card in the PC, boot-up and then run the 
driver installation. In this case the “Found New Hardware Wizard” will pop up again when you first 
boot the PC, but you should close it at this stage and then run the driver setup programs as 
described in step 1. 

For a detailed driver installation description and for troubleshooting driver issues, please refer to the 
‘Dta1xx Installation.pdf’ and/or ‘Dtu2xx Installation.pdf’ documents included in driver ZIP files. 

http://www.dektec.com/Downloads/Drivers.asp
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3.2 Software installation 

When setting up an Xpect server there are two software installs required. First you will need to install 
the Xpect Configuration Tool and then the Xpect server software. For the Service decoding feature 
you will need to install the Microsoft Expression Encoder.  

The Xpect Configuration Tool provides you with a facility to create and edit the configuration files 
required by the Xpect software (see §4.2 Creating/editing configuration files). 

The Xpect server software consists of the main Xpect monitoring application (Xpect.exe) and a 
companion ‘guardian service’ (Xpectguardian.exe) which is used to systematically stop and start Xpect.  

The table below describes the basic steps for setting up an Xpect server. 

# Action Description 

1 Make sure you have the latest 
versions 

 Download the zip file ‘Xpect.zip’ with the latest version of 
Xpect and configuration tool from the DekTec website 
(http://www.dektec.com/Downloads/Applications.asp); 

 Continue to step 2 
2 Install configuration tool  Run the configuration tool (‘Config Tool Setup.exe’); 

 Follow the instructions of the setup program; 
 Continue to step 3 

3 Install Xpect server  Run the server setup program (‘Xpect Setup.exe’); 
 It is recommend that you let the installer perform a 

complete installation; 
 The Installer will start separate installers for: 

o VC9 Runtime 
o Microsoft  Expression Encoder 4 (part of this 

installation could be a separate web install 
of the .NET framework 4.0) 

 Continue to step 4 
4 Create the General configuration 

file1 
 Start the Xpect Configuration Tool2. 

- Select File->New->General to create a new general 
configuration file; 

 In the “General Settings” section: 
- Set your configuration mode password (this is needed 
to protect remote access control of Xpect); 

 In the “Video & Audio Streaming” section:  
- Set Maximum number of allowed parallel streaming 
sessions3 or disable streaming. 

 The setting in the “Time Windows” section can be left at 
their default values; 

 In the “Interface Settings” section:  
- Ensure the SOAP / Web Interface is enabled4; 
- Set the SOAP/Web server port or leave it on the 
default value of 5089; 

                                              
1 The General Configuration File will be unique to your server configuration; Xpect will not start correctly 
unless the general configuration (XpectGeneralConfig.xgen) is set-up to match the configuration of the server 
hardware) 
2 The XCT must be run locally on the Xpect server for creating a General configuration file; 
3 Make sure sufficient memory and CPU resources are available for all streaming sessions  
4 If you plan to use SNMP enable the SNMP interface as well. 

http://www.dektec.com/Downloads/Applications.asp
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 In the “Transport Streams” section: 
- Add the number of TSs you will be monitoring (‘right-
click’ to add/remove transport streams) 

 For each transport stream:  
- Enter a unique name; 
- Select the Licence Type (SPTS Radio/TV or MPTS); 
- On the Adapter pane select the DekTec input adapter 
(and its port) from the drop down list and if needed 
configure the RF or IP settings; 
- All other settings can be left at their default value; 

 Save the new configuration file in the following 
directory: 
- Windows XP/2k3:  ‘C:\Documents and Settings\All 

Users\Documents\DekTec\Xpect\Config’; 
- Vista, 2k8 or Win 7: 
’C:\Users\Public\Documents\DekTec\Xpect\Config’; 

 Continue to step 5 
5 Reboot the system  Reboot the PC; 

 Continue to step 6 
6 Test the installation  Open an internet browser (recommended: IE7/8 or 

Google Chrome); 
 Go to http://localhost:50895 

- It is possible that the browser will prompt you to install 
the Silverlight 4 runtime; if so, please follow the 
installation instructions shown in the browser. 

 The Xpect web GUI should now be loaded (note all 
Xpect instances will automatically start when the PC 
booted) – if the GUI does not load please refer to: §6.2  

 The Xpect Web GUI will indicate the Transport Stream 
overall status: ‘LEDs’ (in the left hand pane) will either 
be Red (indicating TR 101 290 or Template or Extra Test 
errors have been detected) or Green (if no errors are 
currently being detected). If the ‘LEDs’ are grey then 
either there are no syncs present or Xpect is not yet 
monitoring; 

 Greyed out ‘LEDs’ in the right hand pane mean that the 
condition is not currently being monitored. 

 You should now be able to browse through the status of 
the transport streams you have configured. 

 The basic setup process is now completed. 

After successfully completing the steps above, you will have Xpect running in its most basic setup. 
You may now wish to further set up Xpect by creating templates and custom TR 101 290 
configurations. More details about the configuration files used by Xpect can be found in §4. 
Configuration Files. For more details about the Web GUI please refer to §5. Web GUI. 

REMARK: For using the Video Streaming function on Windows Server 2008 make sure that the Windows Feature 
‘Desktop Experience’ is enabled: Administrative Tools - Server Manager - select Features - Add Feature Desktop 
Experience (including Ink and Handwriting Services)  

                                              
5 NOTE: if you changed the default SOAP/Web port replace 5089 with the port you specified 
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4. Configuration Files 

Xpect is configured using a set of XML configuration files. The table below lists the different 
configuration files used by Xpect. 

Type File extension Description 

General .xgen The master configuration file. It defines the number of transport-
streams to monitor, sets parameters for SOAP/WEB/SNMP 
interfaces, specifies files locations and sizes of log/statistic 
databases, etc. 
 
NOTE: There can only be one general configuration file and it 
should always be named ‘XpectGeneralConfig.xgen’. 

TR 101 290 .x290 Configuration file for the TR 101 290 priority 1, 2 & 3 tests. Each 
individual test can be enabled or disabled and the custom limits can 
be specified. 
  

Template .xtpl Configuration file for template matching. The file defines which 
services, tables and basic-streams are expected in a transport 
stream and defines a set of properties for each item in the template 
(e.g. min/max bitrate, PID, service name, scrambled or not, etc). 

Extra tests .xtst Configuration file for a set of tests which extend the standard 
TR 101  290 Priority 1, 2 & 3 tests. The extra tests include: Delay 
Factor, Packet Loss Rate and Table version tests. Each test can be 
enabled and disabled and the limits for the extra test can be 
specified. 

4.1 Configuration file location 

There can be multiple different configuration files present on the Xpect server, except for the general 
configuration (XpectGeneralConfig.xgen), as long as each has a unique configuration ID. This allows 
you to define multiple sets of TR 101 290, Extra test or Template configurations and, via their unique 
configuration IDs, instruct Xpect to apply them to your monitored transport streams. The active 
configuration is initially determined by the settings in the General configuration file (which contains a 
setting per TS specifying the configuration IDs of the configuration files that should be used). 
However, these can be overridden by user configuration files even after Xpect has started 
monitoring. 

For Xpect to find the configuration files they should be stored in the following directory on the Xpect 
server PC: 

Win XP/2k3  ‘C:\Documents and Settings\All Users\Documents\DekTec\Xpect\Config’ 

Win Vista/2k8/7 ‘C:\Users\Public\Documents\DekTec\Xpect\Config’ 

The files located in this directory are typically created by the Xpect server administrator as a set of 
default configurations which are available at all times. Next to these “permanent” files it is also 
possible to dynamically upload user-created TR 101 290, Extra Test or Template configuration files 
to Xpect. 

As soon as you upload a user configuration it will become active (i.e. Xpect will start using it). At any 
time there can only be one user configuration active per configuration type and per transport stream 
instance. As soon as you upload a new user configuration file or restore one of the ‘permanent’ 
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configurations, the current user configuration will be replaced. Loading a new ‘user’ or ‘permanent’ 
configuration file will cause the Xpect monitoring instance to stop and restart (these will be logged in 
Xpect’s Event log which is visible via the web GUI). 

The General configuration cannot be modified while Xpect is running. Changes to the General 
configuration will require manually stopping and restarting of Xpect (via the Xpect guardian) as this 
could involve major changes to the hardware configuration of Xpect. 

Xpect is stopped by stopping the Xpect guardian service in the Windows Services window as follows: 

Windows Control Panel->Administrative Tools->Services (local) 

Select ‘DekTec Xpect Guardian’ within the list of Services, then click ‘Restart the service’. 

4.2 Creating/editing configuration files 

Although all types of configuration files are XML-based and can be created or edited using any text 
editor, it is highly recommended that you use the Xpect Configuration Tool (XCT). The XCT provides 
a specialised interface for each configuration type and ensures that the XML fields generated are 
correctly formatted. Upon creation of a new configuration file it will initiate each setting to sensible 
default values and for a template it is even possible to dynamically fill the template based on the 
current state of a monitored transport stream. This means you can instruct the XCT to download the 
current transport stream status from Xpect and automatically fill the template with a set of rules for 
the services, tables and basic-streams detected in the monitored TS; afterwards only minor 
adjustments are required to get a valid configuration. 

The XCT can also connect remotely to an Xpect server to upload a user configuration and/or load 
an active configuration from the Xpect server right into the tool. 

NOTE 1: Creating or editing a General configuration file should always be done on the Xpect 
server itself. Also note that the “permanent” configuration files should not be uploaded via the 
upload functionality in the XCT, but should be copied to the configuration directory mentioned in 
§4.1 Configuration file location. 

NOTE 2: the default configurator password is: “admin” 

4.2.1 Creating a new TR 101 290 configuration file 

To make a new x290 configuration file you can use the Xpect Configuration Tool (XCT) too either 
create one from scratch (File->New->TR101290) or import and edit the current configuration from 
a running Xpect instance using the ‘Import from Xpect’ button on the toolbar. To connect to the Xpect 
server use the ‘Connect to Xpect’ button on the XCT toolbar (you will need to enter the Configurator 
password specified in the General configuration to do this). For this task the XCT application can be 
run remotely to the Xpect server. 

Once you have modified the tests to be made and entered a Configuration ID for this new 
TR 101 290 configuration file, it should be saved. It can then be uploaded to Xpect using the ‘Export 
to Xpect’ button on the XCT toolbar. 

NOTE: The Configuration ID embedded within each of the configuration files need not 
necessarily be the same as the filename; however it may be helpful to ensure they are similar. 
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4.2.2 Creating a new Template configuration file 

To create a Template configuration file from a monitored stream via the XCT, start with a new 
template (File->New->Template), then connect to the Xpect server using the Connect to Xpect button 
on the toolbar (you will need to enter the Configurator password specified in the General 
configuration to do this). Once connected, select the Configuration from TS Analysis button on the 
toolbar; when prompted by a pop-up, confirm that you wish to Continue and discard changes from 
the template. Next, select which transport stream you wish to analyse using the drop down Selected 
Transport Stream box. Decide which of the Template tests you wish to enable using the check boxes. 
A pop-up will then advise whether the Configuration has been created successfully. 

Once you have entered an ID for this new template it should be saved. It can then be uploaded to 
Xpect using the ‘Export to Xpect’ button on the toolbar. 

NOTE: Xpect will momentarily stop monitoring whenever a new configuration is specified. 

4.2.3 Creating a new Extra tests configuration file 

To make a new Extra Tests configuration file you can use the Xpect Configuration Tool (XCT) to 
either create one from scratch (File->New->Extra tests) or import the current configuration from a 
running Xpect instance using the Import from Xpect button on the toolbar. To connect to the Xpect 
server use the Connect to Xpect button on the XCT toolbar (you will need to enter the Configurator 
password specified in the General configuration to do this). For this task the XCT application can be 
run remotely to the Xpect server. 

Once you have entered an ID for this new Extra test configuration file it should be saved. It can then 
be uploaded to Xpect using the Export to Xpect button on the XCT toolbar. 

NOTE: The Configuration ID embedded within each of the configuration files need not 
necessarily be the same as the filename; however it may be helpful to ensure they are similar. 
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5. Web GUI 

This chapter provides a quick introduction to Xpect’s web GUI. The web GUI allows you to monitor 
the live status of each of the transport streams, browse through the event log with all the error 
messages, access stream captures and perform some basic control tasks. 

To connect to the web GUI open an internet browser (e.g. IE7/8, Google Chrome, Firefox 3.x) and 
browse to the URL address for the Xpect web server: 

http://<server_ip_address>:<web_server_port>, where 

   <server_ip_address> = IP address or name of the PC on which Xpect is running 

   <web_server_port> = SOAP/web server IP port (from general configuration file) 

For example: http://10.10.1.21:5089, http://myxpectpc:5089 or http://localhost:5089 

5.1 Main GUI elements 

The screenshot below shows the main GUI elements of the web interface. 

 

A: List of all transport streams monitored by Xpect. Select one to set the focus on it. 

B: A TAB interface with several pages displaying status information about the currently selected 
transport stream. 

http://10.10.1.21:5089/
http://myxpectpc:5089/
http://localhost:5089/
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C: The name of the transport stream that has the focus. The LED indicator is red if there are any 
errors detected for this transport stream, or green if there are none. 

5.2 Real Time status Tab 

The Real Time status tab provides an overview of the current status of the selected monitored 
transport stream. It shows a list with all basic-streams and services detected in the transport stream 
and the status of all compliance and template tests. 

 

A: List of services and basic-streams found in the monitored TS. 

B: Video player panel. Use buttons or service view context menu to change active service. 

C: Status of compliancy tests (TR101290 + Extra Test). Green means no error, red means an 
error was detected, orange means resolved error6 and gray means the test is disabled. 

D: Status of the template matching tests. Green means no error, red means an error was 
detected, orange means resolved error6 and gray means the test is disabled. 

                                              
6 The orange indication will be used to show historical errors, status could be reset to green by using the right 
mouse button options. 
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5.3 Event Log Tab 

Via the Event Log tab you can browse through the error messages in the log database. 

 

A: Filters to select a data/time range of events to show. A ‘Clear Event Log’ trigger will supress 
currently showed events. 

B: List with all or filtered error events. 
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5.4 Recording Tab 

Via the Recording tab you can setup a trigger condition for file capturing and manage the available 
capture files. 

 

A: Trigger controls: used to define the trigger condition, arm the capture process or manually 
force a capture. 

B: Current status of the capture process. 

C: List of captured files. Click on a file to download it from the server. 
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5.5 Configuration Tab 

The Configuration tab allows you to perform basic configuration tasks such as setting up IP 
forwarding or verifying/setting a TR 101 290, Extra Test and Template configuration. These actions 
require you to be in configuration mode; if you try to change a setting you will be asked to enter the 
administrator password for Xpect (as was specified in the General configuration). Once the 
password is entered, it is remembered for the duration of the session. 

 

A: IP forwarding settings. Use to enable/disable forwarding of the monitored transport stream to 
a specific IP address. 

B: Shows the DekTec input adapter used for monitoring. 

C: Lists the “permanent” configuration files located on the Xpect server and allows you to activate 
one by clicking the corresponding checkbox. 

D: Lists the active user configurations (if any have been applied). 
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5.6 About Tab 

The About tab shows the licence, version and copyright information for Xpect, as well as the EULA. 

 

A: Version and licence status information for Xpect. 
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6. Trouble shooting 

6.1 How to verify Xpect is running? 

To check that Xpect is running please try each of the following in turn: 

1) Using a browser (IE8, Firefox or Google Chrome) enter http://localhost:5089/ (assuming 
you are using the default WEB/SOAP port). If the browser cannot display the webpage then 
Xpect is probably not running; 

2) Another way to check whether Xpect is operational is to view the current running services: run 
Windows Task Manager then view the ‘Processes’ tab to see if xpectguardian.exe and xpect.exe 
are both running. 

If Xpect is not running then please refer to the next section. 

6.2 Check the Windows event log for errors 

Xpect and the Xpect Guardian add log events with status and error info in the Windows event log. 
When you run into trouble it is advisable to look in the Windows event log to check for any error 
messages from Xpect or the Xpect Guardian service. 

To view the logged events open the Windows Event Viewer via the Windows control panel: 

Windows Control Panel->Administrative Tools->Event Viewer 

Open the ‘Application’ log and look for the events marked as being from Xpect and/or 
XpectGaurdian. The log messages should provide an important clue as to what may be wrong.  

6.3 Web GUI is not accessible remotely 

If the Web Gui is started on the Xpect server but not on a remote PC then: 

1) Make sure the Windows firewall Allowed Programs: ‘DekTec Xpect 24/7 Transport-Stream 
Monitoring’ and ‘DekTec Xpect Streaming Application’ are enabled on the Xpect server. 

2) Make sure the IP port used for the Web GUI (default: 5089) and configured IP port range for 
Streaming are not blocked by network components. 

http://localhost:5089/
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7. Copyright Notices 

This section defines all the copyright notices associated with the Xpect software package. 

7.1 Xpect software 
 

 
Copyright © 2009-2011 by DekTec Digital Video B.V. 

 

Copyright © 2009-2011 by Fen Technology Limited 
 
DekTec Digital Video B.V. and Fen Technology Limited reserve the right to change products or specifications 

without notice.  

7.2 3rd-party components 

Net-SNMP http://www.net-snmp.org/about/license.html 

zLib http://zlib.net 

OpenSSL http://www.openssl.org 

Firebird http://www.firebirdsql.org/index.php?op=doc&id=idpl 

IBPP http://www.ibpp.org/license 
 
  

http://www.net-snmp.org/about/license.html
http://zlib.net/
http://www.openssl.org/
http://www.firebirdsql.org/index.php?op=doc&id=idpl
http://www.ibpp.org/license


  DTC-720 Xpect – 24/7 Transport Stream Monitoring 
  USER MANUAL 

 24 

8. DTC-720 Xpect Revision History 
 

Revision Date Changes 

V1.3.1.3763 2011.05.27  Added support for DTA-2136 
 Added Web GUI Orange Led indicators clear all inputs function 

 Added Web GUI persisted storage of Orange Led status; cleared Orange 
indicators will not be shown again after restart of the web browser, unless a 
new Orange status has occurred  

 Fix for possible mismatch MPEG Audio Elementary Stream info 
 Fix for possible invalid minimum bitrate on missing Basic Streams for XCT 

‘Template from TS analysis’ function 

V1.3.0.3732 2011.04.28  Added live Service decoding in Web GUI; support for MPEG-2 Video, AVC 
Video,  AC-3 Audio, AAC Audio, HE-AAC Audio, MPEG-2 Audio and MPEG-1 
Audio 

 Added Orange Led indicator for historical errors 

 Added Clear Event log function in Web GUI 
 Added extra Elementary Stream info in Web GUI 

 Added TS details like IP address in Web GUI header 
 Improvements in Web GUI error reporting 

 Fix for possible Unicode characters problem in service names 
 Fix for possible inconsistent overall status 
 Fix for possible invalid minimum bitrate for XCT ‘Template from TS analysis’ 

 Fix for invalid Buffer Errors on High profile MPEG-2 video 
 Fix for not correctly handled shared service components 

 Fix for Web GUI stream type mismatch 
 Fix for possible no response in password dialog of Web GUI 

V1.2.1.3616 2011.02.03  Added extra field for TS name in SNMP Xpect MIB 

 Fix for ordering of SNMP MIB test results 
 Fix for SNMP Overall Template test result 

 Fix for ‘unknown’ SNMP test results status at startup 

V1.2.0.3530 2010.11.04  Support for Multi TS grid in Web GUI 
 Guardian service improvements 

 Fix for disabled reported 3.2 error 
 Fix for invalid config id error message in Configuration Tool 

V1.1.0.3447 2010.09.27  Support for 64 bit Windows OS (600Mbps support) 

V1.0.0.3295 2010.02.16  Initial release 

 


